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W TAPPING THE

KOMPUTER ENTHUSIASTS OF GREATER SEATTLE

Prez Says: Ron Cowger

Here we are well into summer and warmth normally associated with this season has finally
shown up in our area. Now the plants and flowers finally think it’s summer and are trying
to catch up. All of our plants are far behind their normal maturity for early August, except
for the weeds, and I don’t think we will get much fruit this year. Oh well, that’s one of the
“features” of living in the Pacific Northwest. Reminds me of an explanation | heard once
of a quirky action that a computer program kept doing. It was a “feature.”

I missed the July General Meeting as | was out of town. I’m told that it was an interesting
presentation on the ACN video phone. It looks like a very neat device and | really like the
fact that it can be a digital picture frame when not in use as a phone. However, | don’t
know anyone that | want to call that has one so | guess that I’m not in the market for one.
I’ll get by with Skype for those times when | want to see the person that | am calling.

The presentation at the August meeting will be from Smart Computing Magazine. It will
include an explanation of the key features of their magazine and each person in attendance
will receive a free copy of the current issue. | have been a subscriber for quite a few years
and feel that I get a lot of good out of the magazine. Some of my favorite features are the
articles containing information about new products, product evaluations/comparisons and
tips on how to perform various functions on different software and hardware products. |
think one of their best features is the free tech support that they offer to subscribers. It’s
hard to get good tech support these days, especially from someone for whom English is the
person’s native language. The two door prizes that Smart Computing is providing are (1)
a year’s subscription to the magazine and (2) for those who save back issues, as | do, a slip
cover in which to keep the magazines. | hope that you will attend the General Meeting to
learn more about this fine magazine.

This month there are two new tips from Sharon Parq Associates added to our monthly
newsletter. There is one for using Word and the other for Excel, each designed to expand
our knowledge of these applications. If you want access to additional tips from this com-
pany, you can go to their websites at word.tips.net or excel.tips.net. | think you’ll find the
information interesting and useful.

So far this year, fifty-eight computer enthusiasts have joined or renewed their member-
ships in KEGS. Thanks very much for your confidence in the organization. We finished
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Prez Says: continued

2009 with sixty-three members in our group. We still need to focus on building our
membership throughout 2010. | encourage those of you who have not yet done so to
renew your memberships as soon as possible. Renewal forms are available from John
Tate, our Treasurer, or you can fill out the form on the KEGS web site, print it out and
send it along with your check to the address shown on the form. An even easier way
would be to bring your completed form and your check to the next General Meeting and
give it to John there.

That’s it for now. | hope to see each of you at your favorite SIG. | wish you happy and
safe computing!

Ron Cowger
President
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Word Tip of the Month

Inserting a Non-Breaking Hyphen

When Microsoft Word calculates line length and wraps text to the next line, it tries to wrap (or break)
the line at a space or a hyphen—a dash. Sometimes, however, you may not want Word to break a line
at a dash. For instance, dashes are used in telephone numbers, and you might not want a line to break
in the middle of a telephone number.

The answer is to use non-breaking hyphens instead of regular dashes when you don't want Word to
break a line at the hyphen. To do this, hold down the CTRL and SHIFT keys as you type the dash (this
is the same as typing CTRL and an underscore). Word will then not break the line at that point.

You can also insert a non-breaking hyphen by following these steps:

1. Choose Symbol from the Insert menu or, in Word 2007, display the Insert tab of the ribbon,
click Symbol in the Symbols group, and finally click More Symbols. This displays the In-
sert Symbol dialog box.

2. Click on the Special Characters tab.

Symbol Iili_hj
Spedal Characters
Character: Shortout key:
-
- En Dash Cirl-+HMum -
Maonbreaking Hyphen Ctrl+5hift+_
- Optional Hyphen Cirl+
Em Space
En Space
1/4Em Space
& Monbreaking Space Cirl+5hift+5pace £
=] Copyright Alt+HCHrl+C
® Registered Alt+Ctrl+R
™ Trademark Alt+Ctrl+T
g Section
T Paragraph
Ellipsis Alt+Ctrl+.
Single Opening Quote Cirl+",”
Single Closing Quote Cirl+,'
" Double Opening Quote Cirl+"," 5
AutoCorrect... ] ’ Shaortcut Key. ..
[ Insert ] [ Cancel

The Special Characters tab of the Symbol dialog box
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Word Tip of the Month—continued

Inserting a Non-Breaking Hyphen—continued

3. Highlight the Nonbreaking Hyphen character.
4. Click on Insert.
5. Close the dialog box by clicking on Cancel.

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word
tips can be found online at http://word.tips.net.



August, 2010 Volume 14, Issue 8

& LN
e e L

o AL
SMSSERERIEM ()
G i 2

g ARy

we

=g

Indenting Cell Contents

Microsoft Excel allows you to format the contents of a cell in a myriad of ways. One of the formatting
options you can apply is to indent the contents of a cell by a certain amount. This is similar to indent-
ing done in a word processor, such as Microsoft Word, except that the indenting is specified in a num-
ber of characters, not in a linear distance such as inches or points.

To set the indent to be used in a cell, follow these steps:

Select the cells you want to format.

Display the Format Cells dialog box. (In Excel 2007 display the Home tab of the ribbon and
click the small icon at the lower-right corner of the Number group. In older versions of Ex-
cel choose Cells from the Format menu.)

3. Make sure the Alignment tab is selected.

Format Cells @Ié]

t| Font | Border | Fill |Proter_tion

Text alignment Orientation

Horizontal: . .

General E Indent: *

Vertical; a

Bottom E

Justify distributed

L3

-+ = mo—

Text control .
[ wirap text 0 % | Degrees
[ ] Shrink to fit
[] Merge cells

Right-toeft
Text direction:

Context IEI

| ok || cancal

The Alignment tab of the Format Cells dialog box.
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Excel Tip of the Month—Continued

Indenting Cell Contents—Continued

4. In the Horizontal drop-down list, choose Left (Indent). If you are using Excel 2002 or a later
version, you can also choose Right (Indent).

5. Using the Indent control, specify the number of characters by which the cell contents should
be indented from either the left or right side of the cell. You can pick any whole number be-

tween 0 and 15.
6. Click on OK.

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel
tips can be found online at http://excel.tips.net.



KEGS T-shirts

KEGS GENERAL Rememben you scor exra KEGABUCKS

when you wear your KEGS shirts to SIGS
M E ET] N G and the General Meetings! (NOTE: This
extra credit is not honored at the PIG SIG.)

AND ASSOCIATED SIGS We still have a few left of various sizes.

Then we will order more. So why wait?
Pick yours up at the next general meeting.

General Meetings at the Kirkland Teen Union Building - 348 Kirkland Ave., Kirkland, WA 98033

Day of Month Time Location SIG / Email contact SIG Leader
2nd Monday 6 PM-7PM Kirkland Teen Union Technology Corner Steve Fondren
Building betacode@hotmail.com
2nd Monday 7PM-9PM Kirkland Teen Union KEGS General Meeting
Building
2nd Monday 9:30 PM-?  Outback Steakhouse Pig SIG Sally Ann Mowrey
PM 12120 NE 85 th, Kirkland sallyannmowrey@msn.com 206-996-5635

DRIVING INSTRUCTIONS: From |-405, take the N.E. 85th ST. exit (exit number 18) toward KIRK-
LAND (headed West). Immediately move to the center lane and take a left at the first light onto
Kirkland Way (If you went right you would be on 114th Ave NE). Just stay on Kirkland Way and it
will turn into Kirkland Ave.

The Kirkland Teen Union Building is part of a string of connected buildings. Right at the street is
Kirkland's Performing Arts Center, then comes the Kirkland Senior Center and farthest from the
street is The Kirkland Teen Union Building.

There is a parking area to the West of this building but you can also park in the Kirkland Library's
covered parking area just a little farther to the West ( 1/4 block past the Performing Arts Center).
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KEGS SIG MEETINGS:

NEW SIG CHART

Notice that this SIG chart no longer lists actual dates. Please check our KEGS calendar (at
hitp://www.kegs.org/Calendar.himl) for actual dates AND POSSIBLE CANCELLATIONS of

the upcoming meeting that you want to attend.

Contact the SIG leaders to find out what presentations that they have planned for their up-

coming meetings.

KEGS T-shirts

Remember, you score extra
KEGABUCK$ when you wear

your KEGS shirts to SIGS and the
General Meetings! We still have

a few left of various sizes.
Then we will order more. So

why wait? Pick yours up at the

Meetings at the North Bellevue Community / Senior Center - 4063 148th Ave NE, Bellevue, WA

Day of Month

2nd Tuesday

1st Wednesday

2nd Tuesday

2nd Wednesday

3rd Tuesday

3rd Wednesday

4th Tuesday

4th Wednesday

Time

7PM-9PM

7PM-9PM

7PM-9PM

7PM-9PM

7PM-9PM

7PM-9PM

7PM-9PM

7PM-9PM

Location

Conf. room D

Conf. room D

Conf. room D

Conf. room D

Computer Lab

Conf. room D

Conf. room D

Conf. room D

SIG / Email contact

Digital Video SIG
jackbewitch@comcast.net

Seattle Internet User Group
seasigi@kegs.or

WIN 95/98/XP/??
daviddodgel@compuserve.com

Laptop SIG
ctheprof@aol.com

Computer Support SIG - N. Bellevue
_m_mraz@hotmail.com

(Computer repair & maintenance)

Small Office / Home Office
r_cowger@prodigy.net

Digital Imaging SIG
sallyannmowrey@msn.com

HTML SIG
jackbewitch@comcast.net

next meeting.

SIG Leader

Jack Beslanwich
206-723-9960

Marianne Wilkins

David Dodge

Carl Von Papp
425-643-1398

Joe Mraz
425-747-2433

Ron Cowger

Sally Ann Mowrey
206-996-5635

Jack Beslanwich
206-723-9960
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SIG MEETING LOCATIONS:

Please note that the KEGS Board meetings are not held at our General Meeting or SIG

meeting locations

e KEGS Board Meetings are currently held at Executive Real Estate’s Bellevue office at 20
Lake Bellevue, Bellevue, WA. (Board meetings are public and open to anyone who wants
to attend.)

Finding our primary SIG meeting location

DRIVING INSTRUCTIONS: Thanks to the improvements to SR 520, you may now use the new
NE 40th St exit. If you are driving towards Redmond, exit and turn left to go over the over-
pass. If you are coming from Redmond, exit and turn right. Go to 148th Ave NE, and turn
right. In very short order, you will see the North Bellevue Community / Senior Center sign on
the left side of the roadway.
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HISTORY & CONTACT INFO:

KEGS was formed in late 1996 to meet the needs of personal computer users in the Greater
Seattle Area. KEGS is a nonprofit organization that holds its general meetings on the second
Monday of each month.

In addition, KEGS sponsors a number of special interest groups (SIGs) that meet regularly
to share common interests, learn new techniques, and resolve questions about the use of per-
sonal computer hardware, accessories, or software.

For a detailed listing of our SIG’s, up- Contact us at: Email: info@kegs.org
dated information about KEGS activities, The Komputer Enthusiasts of Greater Seattle
and more, please see our web site at: PMB# 195

677 120th Ave NE, Suite 2A
Bellevue, WA 98005

http://www.kegs.org. Or call 425-747-2433 before 9 PM

To submit articles or software reviews for incorporation into this Newsletter, please send them
to: newsletter@kegs.org
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